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Develop New Content Using the Integrated
Development Environment

The Integrated Development Environment (IDE) allows you to develop content and DWH models,
as well as develop new entities and extend existing content using the Designers. Once the entities
are defined andmapped, they are run through the ETLGenerator to produce themetadata and
workflows. You can then package the data into Content Packs for use in the DataWarehouse.

Tasks
The following describes the various IDE processes:

"Getting Started with Content Extension" on page 7

"Design and Analysis Phase" on page 12

"Content Packs and DataModeling" on page 14

"IDE Main Page and End-to-End Flow" on page 19

"Discover Data Evidence" on page 24

"Import Existing Content" on page 25

"Define New Content Pack Project" on page 26

"Define the Target Model" on page 31

"Architect Target Designer Tasks" on page 32

"Engineer Stream Designer Tasks" on page 45

"Delete an Entity Permanently" on page 56

"Manage Validation" on page 58

"Generate Content" on page 71

"Package and Deploy Content" on page 73

"Activate New Content " on page 74

"Advanced Development" on page 79

"Next Steps" on page 105
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Release Notes

Compatibility
l The IDE version 9.4 is compatible with all previous XS versions.

What's New in this Version
Target Extension

The IDE supports the extension of a target entity by creating an association called Target
Extension. This enables you to extend an entity by adding to the new entity columns. Adding an
extension enables Fact extension and the ability to link a group of Dimensions specifically to the
same group. You then use the extension entity to make all associations and links. Target extension
is only supported in XS version 9.4 and later.

Issues

Issue Description

Period
dimension
Extension

The Period target entity requires special mapping requirements in the IDE. The
entity contains time and date relatedmapping and can only extend to date related
sources and dimensions, for example START_TIME.
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Getting Started with Content Extension
This document assumes basic data warehousemodeling knowledge, understanding of the ETL
concepts, good familiarity with databases, as well as SAP Business Objects Data Services
(BODS). When creating or extending content make sure that you have set up Executive Scorecard
as well as installed the contents of the IDE DVD. For IT Executive Scorecard installation and
administration details, see the IT Executive Scorecard Administrator Guide.

IDE Terms
IDE: Integrated Development Environment

The Eclipse workspace where you can create or extend content usingmodeling tools in the relevant
designers.

KPI: Key Performance Indicator

KPIs reflect how well the organization is doing in areas that most impact financial measures valued
by shareholders, such as profitability and revenues.

API: Application Programming Interface

A specification intended to be used as an interface by software components to communicate with
each other.

ETL: Extract, Transform, Load

An end-to-end transfer of external source data through several staging layers and into the target
layer of the data warehouse. The data warehouse uses the ETL process to extract, consolidate,
and transform the source data into ameaningful target model that populates relevant business
analytics.

UDM: Unified Data Model

Provides a bridge between the user and the data sources.

DWH: Data Warehouse

The data warehouse is an end-to-end solution for extracting source data and consolidating disparate
source datamodels into a consolidated datamodel. The data organized to reflect this model resides
in target tables that become the source for Executive Scorecard.

XS: Executive Scorecard

An application that enables executives to continuously improve their business by measuring what
happened and what is happening, analyzing that information, and planning new strategies using the
gathered information.

File Based Integration (FBI) Extractor

FBI enables you to extract data from a specific data source according to a set of instructions. It
consists of a plug-able extractor framework for each data source. The extractor gathers data
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according to the specific instructions it receives, placing it into a relevant .txt flat file. If you want to
develop your own extractor for use with extended content, see the FBI Extractor SDK Guide.

The following extractors are available for each source product:

Product Extractor

ALM ALM

AM MSSQL, Oracle

AWS aws_s3

AWSCW AWSCW

BSM BSM, GDE, UCMDB

CSA CSA

DP DP

FPA FPA

IC MSSQL, Oracle, PostgreSQL

NA MSSQL, Oracle, MySQL

NNM NNM

OO MSSQL, Oracle, MySQL

PPM Oracle

SA SA

SE Oracle

SM MSSQL, Oracle

UCMDB UCMDB

VCM script(groovy)

Entity

An entity is an object of interest included in the datamodel.

Designer

A designer in the IDE is themodel you create in order to perform content extension and definition. It
is a collection of certain entities that may share some relevancy in common. The IDE contains the
Architect Target Designer and the Engineer Stream Designer.

Content Packs

A content pack is a set of entities from a certain type. There are three types of content packs:

Content Extension Guide for XS IDE Version 9.4
Getting Started with Content Extension
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Source: Contains all of the artifacts needed to connect to the relevant data source and pull data
from that data source.

Integration: Integrates the information from the source, using the DWH schema and loading
process in order for the data to be brought to the Target tables. Takes the schema and entities of the
source data and transforms it into usable data.

Target: Defines the content of the DataWarehouse as well as the look of the target tables
according to the Unified DataModel (UDM).

IDE Requirements
Required for DWH Architects

l Understanding of Business Intelligence tools, data warehousemodeling and database design
principles.

l XS DWH Target schema.

Required for DWH ETL Engineers

l Understanding ETL principles.

l Experience with BODS.

l Familiarity with the source schema.

Required for DWH Integration Engineers

l Java programming skills

Prerequisite knowledge for performing content development tasks:

l HP Unified DataModel (UDM).

l Target Model: The existing supportedmodel of the DWH

l Basic architecture of the data warehouse and the advantages of the templates.

l Basic familiarity with the Integrated Development Environment (IDE).

l BODS and datamodeling.

Content Extension Guide for XS IDE Version 9.4
Getting Started with Content Extension
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General Prerequisite

The IDE only supports the usage of UTF-8 (Latin) characters.

IDE Set up
The IDE can be downloaded from HP Live Network (https://hpln.hp.com/group/executive-
scorecard) and contains:

l IDE:Unzip the file and double-click eclipse.exe to run the IDE Eclipse application.

l IDE Content:Contains the OOTB Content Packs.

Content Extension Guide for XS IDE Version 9.4
Getting Started with Content Extension
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Content Extension process
The development of new content comprises the following steps:

1. Data Evidence: Understanding and analyzing what data needs to be included, based on your
information needs and objectives.

2. Import existing content for extension or new Content Pack folders if required.

3. Modeling: The architect creates the Target model.

4. Data Source Integration: The engineer maps the data from the Source to Target.

5. ETL development and generation.

6. ETL orchestration andmanagement.

7. Consolidation

8. Context (universe) building and adjustments.

9. KPIs additions andmodifications.

Content Extension Guide for XS IDE Version 9.4
Getting Started with Content Extension
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Design and Analysis Phase
The information design and analysis phase includes the following process:

Business Discovery
Determine your organization’s objectives and information needs. Business discovery contains the
following steps.

l User Analysis: Define personas and their business requirements.

l Decision Based Analysis: Includes Executive Scorecard KPIs, reports, metrics, and
dashboards.

l Information Availability: Identify the Source systems that support the business requirements.

l Assign Priorities

Information Discovery
Discover the data in the organization that supports the business requirements. Synchronize the
available information and themeans of extracting it with information required. This is the Data
Evidence process. Information discovery includes the following steps.

l Source Contact Point: Select an expert to lead the information discovery process.

l Source ExtractionMethod: DB query, API, Web services.

l Source Table Identification: Identify configuration tables to populate Dimensions,and
transactional tables to populate Facts.

l Source to Target Mapping: Identify Source columnmapping to Target columns and define data-
processing requirements.

Architecture
Comprised of a star schema, a designmethod of dimensional modeling, in which the data is
organized into Facts and Dimensions. A star schema is designed by surrounding each fact with its
associated dimensions.

l Fact:An event that is counted or measured, such as a sale or logon. Table Structure contains
business measurements (numeric or time based) and Dimensional Intersection Point.

l Dimension:Reference information about the fact, such as period, product, or customer.
Common Table Structure contains descriptive attributes.
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Sample Star Schema

Content Extension Guide for XS IDE Version 9.4
Design and Analysis Phase
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Content Packs and Data Modeling
Content packs contain all the artifacts needed to connect to the relevant data source and gather
data from that data source. Themapping between the raw data from the data source and the target
database in the DataWarehouse is included in the ETL. Content packs include:

l The definition of the datamodel used for the connection.

l The type of data gathered from the data source.

l The ETL definitions.

l The definition files.

l The configuration files.

l The scripts that help build and define the DataWarehouse.

Content Pack Types

l Target Content Pack: Responsible for the transfer of data from consolidation to the target
database. The Target CP defines the content of the DataWarehouse as well as the look of the
target tables.

l Integrated Content Pack (i-CP): The i-CPs are responsible for bringing the data from the specific
data sources and transforming it to the consolidation level. From there, the Target CP transfers
the data to the target. The i-CPs integrate the information from the source, using the DWH
schema and loading process in order for the data to be brought to the target tables.

Content Packs contain the following folders:

l ABC: Contains files that define the ETL stream, and the general flow of steps of SAP
BusinessObjects Data Services jobs. The files list the order of the steps as well as the link
between the parent and child steps. These files are necessary if you have to add a step to the
ETL process.

l Custom: Contains SQL scripts that are not part of the standard ETL processes. For example, if
you want to include a staging table that will help the ETL, the script is placed in the Custom
folder.

l DataModel: Contains the xml files that define the target schema.

l ETL: Contains the jobs and workflows of the ETL and defines how data goes through the
processes.

l cp_manifest.properties: Themanifest file provides additional information to the Content Pack to
allow the system to perform sets of validations.
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l dw_app.properties

l dw_app.xml: Files that are created automatically when you add a new CP.

Data Model Types
Datamodels describe the source, extraction, consolidation, and target components for a single
entity:

Target Entity

Fact or Dimension: Entity name and column names defined according to the Star-Schema
architecture.

Source Entity

The actual representation of an entity extracted from the source.Generated automatically according
to the integration entity design.

Integration Entity

Entity name, column names, and data types defined according to source table design.

Column Mapping

Source to Target columnmapping.

Logical Data Models
DWH supports the following types of logical datamodels:

l Target Data Models:

n Target Model – Dimension or Fact: The target datamodels describe the format of the data
that produces business intelligence analytics. The instantiated datamodels are dimension,
fact, and hierarchy tables.

l i-CP Data Models:

n Extraction Model:ETL processes obtain the data in native format and stages it in
intermediate tables that conform to the extraction datamodel for that entity. Extraction also
validates the data to ensure that it is usable.

n Source Model: The source entity models represent the design of DII (Data Integration
Interface).

Physical Data Models
DWH logical DataModels generatemultiple physical tables that support the ETL processing logic.

Content Extension Guide for XS IDE Version 9.4
Content Packs and DataModeling
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l Source entity models: The source entity models are the data produced by an external
application. Used for a specific version of the product, for example ALM 10/MSSQL, ALM 11
Oracle.

l Extraction models:ETL processes obtain the data in native format and stage it in intermediate
tables that conform to the extraction datamodel for that entity. Extraction also validates the data
to ensure that it is usable.

l Consolidation models:Consolidationmodels transform the data further by merging extracted
data from diverse sources intomeaningful data required by applications.

l Target models: The target models describe the final version of the data that adheres to the
design required by applications.

Datamodels describe the source and extraction format so that the data warehouse can consume
this data and integrate it into a common view that you can use to populate comprehensive business
intelligence reports and dashboards.

Each table contains both designed columns and static columns, also known as metadata columns,
so that the administrator can have the visibility of ETL processing over the entity’s data.

Content Extension Guide for XS IDE Version 9.4
Content Packs and DataModeling
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Data Warehouse Internal Fields
The following are the internal DataWarehouse fields, in addition to those in the IDE, that are added
to themodel.

Field Name Prefixes Description

MD_BATCH_ID ETL stream ID displayed on all Physical Models.

MD_PROCESS_ID ETL Process ID running the specific job.

MD_DURABLE_KEY Entity’s unique identifier populated with MD_ENTERPRISE_KEY
value.

Displayed only in Target Physical Models

MD_ENTERPRISE_
KEY

Entity’s unique identifier in the DWH system.

Displayed only in Consolidation Physical Models

MD_BUSINESS_KEY Entity’s unique key as it comes from the source systems.

Displayed only in Consolidation and Extraction Physical Models

MD_TRANSLASTIND Indicator whether the line is the last transaction of a specific MD_
DURABLE_KEY.

Displayed only in Target Physical Models

MD_
ACTIVESTATUSIND

Indicator whether the line is active (simulates delete operation).

Displayed only in Target Physical Models

MD_
TRANSENDDATE

Transaction end date.

Displayed only in Target Physical Models

MD_DELETEDDATE Delete date (date record was marked as inactive).

Displayed only in Target Physical Models

MD_CREATEDDATE Date record was created.

Displayed only in Target Physical Models

MD_LASTMODDATE Date record was last modified and updated.

Displayed only in Target Physical Models

MD_FLAG Flag that indicates whether row is new, updated, or requires a delete.

Displayed only in Consolidations and Extractions Physical Models

Content Extension Guide for XS IDE Version 9.4
Content Packs and DataModeling
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Field Name Prefixes Description

MD_PF_FLAG Flag that indicates whether row is pre-filled or not.

Displayed only in Extractions Physical Models

MD_QUALIFIER Unique identifier of an Entity across all Sources, that allows
consolidations (like “Consolidation Rule”).

Example “NODE” entity qualifier is FQDN Node name.

MD_CP_ID Source instance ID

Content Extension Guide for XS IDE Version 9.4
Content Packs and DataModeling
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IDE Main Page and End-to-End Flow
The IDE main page enables you to create Designers for the purpose of extending content to
entities. The following describes the IDE main page and icons as well as the tasks and flow of the
IDE process.

The IDE Eclipse Main Page
The IDE requires basic knowledge of Eclipse and its capabilities. The following describes the IDE
layout and icons. SelectWindow > Show View to add to and change the view of the various tabs
and areas.

Note: It is recommended to select the IDE Perspective by clicking .

The IDE perspective contains all of the relevant buttons, areas, and functionality
for working in the IDE.

IDE Workspace: Main area where all IDE functions are located.
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User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

Package Explorer A list of all of the available loaded Content
Packs and Designer diagrams.

Canvas Displays model diagram.

Problems Displays validation errors and warnings.

Properties Displays property tabs according to the
selected entity in the Designer.

Error Log Reports system errors.

Data Source Explorer Enables you to connect to a specific data
source and browse the database.

ETL Generation. Appears when a
designer is open in the canvas. Click to
perform the ETL process and generate the
artifacts and create a new Content Pack.
For details, see "Generate Content" on
page 71.

BODS Export. Click to perform BODS
export process. For details, see "Export
from BODS" on page 80.

Save. Click to validate and save your
mappings and configurations.

Report a Bug. Click to gather information
for a bug report packaged in a ZIP file.

Validate. Click tomanually perform
validations on the Designer.

Perspective. Select to switch to
recommended IDE perspective.

This perspective contains all of the
relevant buttons, areas, and functionality
for working in the IDE.

Content Extension Guide for XS IDE Version 9.4
IDE Main Page and End-to-End Flow
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IDE Icons

Icon Description

Indicates a Target entity.

Indicates an Integration entity.

Indicates a Source entity.

Indicates a Target extension entity.

Indicates a Integration entity column.

Indicates a Fact entity column.

Indicates a Dimension entity column.

Indicates an association between Fact and Dimension entities.

Indicates an association between Dimension entities.

Indicates a columnwhich exists both as a Fact and as a Dimension.

Indicates a consolidation column.

Warning that appears when you save a problematic change to amodel that might
cause an error at a later stage in the process. You can view the details by hovering
over the icon on themodel or in the Problems tab.

Error that appears when there is a design problem with your model in a designer.
For example, the length of a column is too long. You can view the details by
hovering over the icon on themodel or in the Problems tab. Right-click an error to
check if Quick Fix has been enabled for the problem. For details, see "Manage
Validation" on page 58.

Content Extension Guide for XS IDE Version 9.4
IDE Main Page and End-to-End Flow
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The IDE End-to-End Flowchart
The following illustrates the typical tasks and procedures in the IDE. The tasks correspond to the
relevant tasks in the Designers.

Content Extension Guide for XS IDE Version 9.4
IDE Main Page and End-to-End Flow
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Discover Data Evidence
It is necessary to understand and be familiar with the new data you want to develop. When there is
a new source system involved, youmust first understand how the data from the source appears
and operates.

Data Evidence can be done as follows:

1. Understand how to extract the data.

2. Take sample files extracted from the source.

3. Examine different fields that this source provides: It is important to recognize the fields and
data which come from the source and to define the names of the fields as the source tables.

4. Define and plan in advance which extractors provide data for specific entities.

5. Understand variety, different lists of values, end-cases.

6. Observe data behavior over time:

a. Understand what happens with data across time – is it the same file, only different dates?

b. Sizes of rows and volumes by types of customers.

c. Identify how this data correlates with existing data in the DataWarehouse.

At the end you should have a good sense of what this data looks like and how to develop
extraction code for it.

7. Identify:

a. What is the required data to be available in the Target schema to support required KPIs.

b. What is the data that can come from the source (depending on technology).

c. Where do they meet in themiddle, so eventually we have the outcomes of the extracted
data and the DWH Target model.

d. For which columns do you want to preserve history.

After mapping between the Source and the Target, the design process is complete.
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Import Existing Content
When you extend your existing content using the IDE, youmust import the relevant content packs
you want to work with.

Note: Youmust import the Target Content Pack (cp-core) in order to extend or create content
in the IDE.

1. Navigate to File > Import > General > Existing Projects into workspace and click Next.

2. Browse for the cp-core folder and click OK, click Finish to import the project.

3. Import all of the relevant content packs you need to work with.

4. Proceed to creating the Designers.
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Define New Content Pack Project
The IDE comes with out of the box Content Packs which you can import to add and extend content.
You can also create projects based on data from new content folders, which youmust manually add
and define.

Note: Youmust import the Target Content Pack (cp-core) in order to extend or create content
in the IDE.

Section Navigation: l Tasks l UI Description

Tasks
To create new projects from content folders:

1. Select File > New > Other > DWH IDE > Content Pack.

2. Select the type of project: Source or Integration.

3. Enter the relevant details for the project and click Next.

4. Select the relevant Content Pack reference for the project:

n For new Integration CP select the Target Content Pack for the project.

n For new Source CP select the Integration Content Pack for the project.

5. Click Finish.

6. Proceed with defining the Architect Target and Engineer Stream Designer projects. For details,
see "Architect Target Designer Tasks" on page 32 and "Engineer Stream Designer Tasks" on
page 45.
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UI Description
Integration

User interface elements are described below:

UI Element Description

Product Name Name of the source product.

Make sure that after you define the product name, you can view the file under
the Integration project icp.dwmodelappintegration file.

Use Default
Location

Select to use the displayed location for your new project.

Location Browse to the location of the content folder.

Content Extension Guide for XS IDE Version 9.4
Define New Content Pack Project
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UI Element Description

Add project to
working sets

Select to add this project to the current set of projects.

Working Sets Select new working sets.

User interface elements are described below:

UI Element Description

Referenced projects Select the Target Content pack for the new Integration project.

Content Extension Guide for XS IDE Version 9.4
Define New Content Pack Project
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Source

User interface elements are described below:

UI Element Description

Product Name Name of the source product.

Make sure that after you define the product name, you can view the file under
the Source project scp.dwmodelappsource file.

Version Enter the data source version.

Product Type Enter the data source type.

Use Default
Location

Select to use the displayed location for your new project.

Location Browse to the location of the content folder.

Content Extension Guide for XS IDE Version 9.4
Define New Content Pack Project
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UI Element Description

Add project to
working sets

Select to add this project to the current set of projects.

Working Sets Select new working sets.

User interface elements are described below:

UI Element Description

Referenced projects Select the Integration Content pack for the new Source project.

Content Extension Guide for XS IDE Version 9.4
Define New Content Pack Project
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Define the Target Model
Before working with a specific designer, you should define the Target model and the related
associations andmappings. The Target model describes the final version of the data that adheres
to the design required by applications. Each table in themodel contains both designed columns and
static columns, which comprises themetadata, so that the administrator can have the visibility of
ETL processing over the entity’s data.

Target Model – Dimension or Fact: The target datamodels describe the format of the data that
produces business intelligence analytics. The instantiated datamodels are dimension, fact, and
hierarchy tables.

In the Architect Target Designer you define the target model containing the entities and links
between them.
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Architect Target Designer Tasks
The Architect Target Designer enables you to define a Target entity as well as link associations, or
extend an existing entity. Each Target entity in the Architect Target Designer contains columns of
fact, or dimension (or both) and associations to other Target entities.

Architect Target Designers can contain one or more Target entities. Usually each Architect Target
Designer includes several entities that are related to the same subject (Designer). Target entities
can be included in several Architect Target Designers.

The IDE supports the extension of a target entity by creating an association called Target
Extension. This enables you to extend an entity by adding to the new entity columns. Adding an
extension enables Fact extension and the ability to link a group of Dimensions specifically to the
same group. You then use the extension entity to make all associations and links.

Note: Make sure you have selected the IDE perspective before beginning to work on your
designer diagram.

Note: It is recommended to create a separate general project in the Package Explorer for the
Architect Target Designer files.

Section Navigation: l Learn More l Tasks l UI Description

To access:
In the IDE main page,select File > Architect Target Designer.

Learn More
The Architect Target Designer enables the following:

l Create a new entity metadata which is translated into the Target model.

l Load an existing Target entity.

l Add columns which affect entity generation.

l Add associations between entities.

n Link a Fact to Dimension

n Link a Dimension to Dimension

n Link an entity to an extension
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Tasks
This section includes:

"Create a new Architect Target Designer in the IDE:" below

"Define a new Target entity:" below

"Load an existing Target entity:" below

"Extend a Target Entity:" on the next page

"Add a column: " on the next page

"Link a Dimension to a Dimension:" on page 35

"Link a Fact to a Dimension:" on page 35

"Extend custom ITFM Entities:" on page 35

Create a new Architect Target Designer in the IDE:

1. In the IDE main page, select File > Architect Target Designer and click Next.

2. Select the parent folder and enter the file name for the Stream Designer diagram and click
Next.

3. Select the relevant Target Content Pack directory and click Finish.

Define a new Target entity:

1. In the Architect Target Designer, in the palette area, select New Target Entity and click on the
canvas.

2. Name the entity.

3. Add relevant columns to the entity.

4. Click Save.

Load an existing Target entity:

1. In the Architect Target Designer, in the palette area, select Load Target Entity and click on
the canvas. The Resource Selector dialog box opens.

2. Expand the target folder and select an entity. The entity is displayed with all of the previously
added columns and dimensions.

3. Add relevant columns to the entity. You can then edit and configure columns in the Properties
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view.

4. Click Save.

Extend a Target Entity:

1. In the Architect Target Designer, in the palette area, select Load Target Entity and click on
the canvas to load the target entity that you want to extend. The Resource Selector dialog box
opens.

2. Expand the target folder and select an entity. The entity is displayed with all of the previously
added columns and dimensions.

3. Select New Target Entity and click on the canvas to add the entity which will be the target
extension.

4. Name the entity. If you are extending the Person entity, for example, you can enter PERSON_
CSTM.

5. In the Properties tab of the new entity, configure the entity Type (Fact orDimension). Must be
the same entity type as the base entity.

6. In the palette area, click Target Extension.

7. Drag the arrow from the new extending entity to the original loaded entity.

8. This relation creates an extension to the new entity. The new entity name is displayed as an
extension in the original entity. You can add relevant columns and configure the extended
entity as necessary. Mapping is then done from the Integration to the Target extension.

Note:

n The extending and base targets are referred to as a single entity. Therefore, you can not
add a columnwith the sameColumn ID of one in the original base entity.

n When you add an extension, make sure that the Source and Target are from the same
type.

n Target Extensions can also be extended.

n The name of the extension is derived from the name of the extended entity and cannot
be changed.

Add a column:

1. In the Architect Target Designer, in the palette area, select Target Column.

2. Click in the Column area of your entity and enter the Column ID in the text box.
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The column is added to the entity. You can then edit and configure columns in the Properties
view.

3. Click Save.

Link a Dimension to a Dimension:

1. In the Architect Target Designer, in the palette area, click Dimension to Dimension.

2. Drag the arrow from aDimension to the Dimension you want it linked to.

3. The New Dimension to Dimension dialog box opens. The default name is displayed and can be
edited. This relation links a Dimension entity to another Dimension.

Note: If you link to an entity from an existing association, you can connect using the arrow
without naming the Associated Dimension.

The default Associated Dimension name is the Target entity.

4. Click Save.

Link a Fact to a Dimension:

1. In the Architect Target Designer, in the palette area, click Fact to Dimension.

2. Drag the arrow from the Fact entity to the Dimension you want it linked to.

3. The New Fact to Dimension dialog box opens. The default name is displayed and can be
edited. This relation links a Fact entity to another Dimension.

Note: If you link to an entity from an existing association, you can connect using the arrow
without naming the associated Dimension.

The default associated dimension name is the Target entity.

4. Click Save.

Extend custom ITFM Entities:

1. In the Architect Target Designer, in the palette area, select Load Target Entity and click on
the canvas to load the target entity that you want to extend. The Resource Selector dialog box
opens.

2. Expand the target folder and select either ACTUALCOST_CSTM or PLANNEDCOST_CSTM
(custom extended) entities. These two ITFM entities comeOOTB with custom extension
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entities that can be further extended through the ACTUALCOST_CSTM or PLANNEDCOST_
CSTM entities.

UI Description
Create Architect Target Designer

User interface elements are described below:

Content Extension Guide for XS IDE Version 9.4
Architect Target Designer Tasks

HP IT Executive Scorecard (9.41) Page 36 of 108



UI Element Description

Enter or select the parent
folder

Select the folder in which this Designer will be contained, from
the folder list.

File Name Enter a file name for your Designer diagram.
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Target Content Pack selection

User interface elements are described below:

UI Element Description

Target Content Pack Select or browse for the Target Content Pack directory.
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Architect Target Designer View

User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):
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Palette Area

UI
Element Description

Entities Contains the following Target entity options:

l New Target Entity. Creates a new Target entity. Entity type can be defined
in the Properties tab. To view the Properties tab, right-click on the specific entity
and click Show Properties View.

l Load Target Entity. Opens the Resource Selector dialog box. Select the
relevant entity for your model.

l Target Column. Adds columns to entities. Column properties, for example
column type, can be edited in the Properties tab.

Each added attribute impacts the relevant entity generations.

Target
Entities
Relation

Click a link to create connections for building themodel.

l Dimension to Dimension. Link from one Dimension to another Dimension.
A red arrow is displayed between the entities.

l Fact to Dimension. Link from a Fact to a Dimension. This type of relation
requires that the fact type was defined in the entity properties. A blue arrow is
displayed between the entities.

l Target Extension. Link from a new target entity to the base/original target
entity. A black arrow is displayed between the entities.
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Properties tab for Target entity and specific fields
To view the Properties tab, right-click on the specific entity and click Show Properties View.

You first configure the Target entity properties, and then the properties for each specific column.

UI Element Description

General tab Displays theEntity, Dimension and Fact attributes for the target entity.

General Target entity attributes:

l ID: The ID of the entity.

l Business Name: The complete business name.

l Description:Enter a description of the entity.

l Dimension/Fact Checkbox: Select one or both for the entity.

If you change the selection, a dialog opens, warning that youmay lose
information previously entered in the Columns tab.

Note: Make sure to select the required option connected to the relevant Fact
or Dimension column properties.
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UI Element Description

Columns
tab

Displays information for each column in the Target entity. Column property
options are displayed according to the entity selection of Fact or Dimension in the
General tab.

l ID. The ID of the entity.

l Business name. The complete business name.

l Description. Enter a description of the entity.

l Data Type. Varchar, Int 16, Int 32, Float, Localized Date Time

l Length. Only for Varchar data type. The length of a Varchar columnmust be
more than 0 and less than 4000.

l Null Allowed. Select if the field can have the value NULL.

l SCD Type. Slowly Changing Dimension type can be either 1 or 2. Only for
Dimension.

SCD1: For update.

SCD2: For preserving history.

l Measure. Select only for Fact.

l Calculation Formula. The calculation of themeasure. (Optional)

l Summary. Select SUM,MIN,MAX, orAVG. (Optional)

Appearance
tab

Displays font and appearance information.
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Properties tab for Associated Dimensions
To view the Properties tab, right-click on the specific entity and click Show Properties View.

UI Element Description

Associations tab Displays Dimension association information:

l ID. The ID of the entity.

l Business Name. The complete business name.

l Description. Enter a description of the entity.

l Type. Select Dimension, Fact, orBoth.

l SCD Type. For Dimension only.

l From Target. The Target entity.

l To Target. The Associated Dimension

Appearance tab Displays font and appearance information.

New Associated Dimension Dialog Box
When you link to an unlinked Dimension, the following dialog box opens.

Edit an Associated Dimension name. The default is the Target entity name.
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Target Extension Entity

OOTB ITFM Custom Target Extension Entity
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Engineer Stream Designer Tasks
The Engineer Stream Designer enables you to define the integrations and how they are transformed
and connected. This view defines themapping relations for the entity from the source to the target.
You can create new integrations based on graphical diagrams, using the Engineer Stream Designer
in the IDE tool.

Note: Make sure you have selected the IDE perspective before beginning to work on your
designer diagram.

To access:
In the IDE main page, select File > Engineer Stream Designer.

Section Navigation: l Learn More l Tasks l UI Description

Learn More
The Engineer Stream Designer enables you to extend and add content from the Integration and
Source Content Packs into the target model. Using a new or existing Target entity, you can add
new or existing content from the Integration and Source entities. You then perform transformation
and Source Integrationmapping for new and pre-loaded entities. The Source, Integration and Target
entities aremapped using the TransformationMapping connector, which creates a new mapping
entity. All further mapping is done to the new entity in order to complete the Target model.

Note: All Source entities must be connected to an Integration entity.

Entities in the Engineer Stream Designer aremapped as follows:

l Source Entity:Mapping to the correct source, meaning the version the data is extracted from.

l Integration Entity:Contains themapping of all fields.

l Target Entity:Several consolidation entities can be consolidated into one entity.

It is recommended tomap from the Source to the Target.

Source Extractors:
OOTB set of existing supported extractors are:

l Generic Extractors

n DB Extractor: Supports MSSQL, Oracle andMySQL databases.

n File Extractor: Supports general CSV file.

l Source Specific Extractor
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n BSM API Extractor:Supporting both GDE and REST calls.

n DP CLI Extractor

n SA SDK Extractor

n NNM Optimized file Extractor:Holds mass volumes of NNM files.

Connecting to the integration:

ETLGen templates in the back-end generate integration templates which utilize File Based
Integration (FBI). Load the Sourcemetadata to the IDE and thenmap it to the correct
consolidation entity in the relevant fields. To create a custom FBI extractor, see the FBI
Extractor SDK Guide.

Important Information

Note: Creating new Target entities with Associated Dimensions can only be done in the
Architect Target Designer.

Tasks
This section includes:

"Create a new Engineer Stream Designer in the IDE:" below

"Define a new Target entity:" on the next page

"Load an existing Target entity:" on the next page

"Define a new integration entity:" on the next page

"Load an existing integration entity:" on the next page

"Define a new source entity:" on the next page

"Load an existing source entity:" on page 48

"Add a column:" on page 48

"Map from the Integration to Target:" on page 48

Create a new Engineer Stream Designer in the IDE:

1. In the IDE main page, select File > Engineer Stream Designer and click Next.

2. Enter or select the parent folder and enter the file name for the Engineer Stream Designer
diagram and click Next.

3. Select the Target, Integration, and Source Content Pack directories and click Finish.
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Define a new Target entity:

1. In the Engineer Stream Designer, in the palette area, select New Target Entity and click on
the canvas.

2. Name the entity.

3. Add relevant columns to the entity.

4. Click Save.

Load an existing Target entity:

1. In the Engineer Stream Designer, in the palette area, select Load Target Entity and click on
the canvas. The Resource Selector dialog box opens.

2. Select an entity. The entity is displayed with all of the previously added columns and
dimensions.

3. Add relevant columns to the entity. You can then edit and configure columns in the Properties
view.

4. Click Save.

Define a new integration entity:

1. In the Stream Designer, in the palette area, select New Integration Entity in the Integration
section and click on the canvas. An integration entity is displayed.

2. Enter a name. The name can be up to 44 characters. An Integration entity is created.

3. Click Integration Column to add a column to the entity.

4. Perform mapping if required.

5. Click Save.

Load an existing integration entity:

1. In the Stream Designer, in the palette area, select Load Integration Entity in the Integration
section and click on the canvas. The Resource Selector dialog box opens.

2. Select an entity. The entity is displayed with all of the previously addedmappings.

Define a new source entity:

1. In the Engineer Stream Designer, in the palette area, select New Source Entity in the Source
section and click on the canvas. A Source entity is displayed.
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2. Click Source-Integration Relation and drag the display arrow from the Source entity to an
Integration entity. All columns from the Integration entity are copied to the Source entity with
default values.

3. Click Save.

Note: The Source-Integration Relation tool only enables you to link Source entities to
Integration entities of the same product (content pack). For example, a Source entity from
cp-bsm-9.01-bsm can only be linked to Integration entities from cp-bsm and not cp-ppm.

Load an existing source entity:

1. In the Engineer Stream Designer , in the palette area, select Load Source Entity in the Source
section and click on the canvas. The Resource Selector dialog box opens.

2. Select an entity. The entity is displayed with its mapped integration entity.

Add a column:

1. In the Engineer Stream Designer, in the palette area, select Target Column or Integration
Column.

2. Click in the Column area of your entity and enter the Column ID in the text box.

The column is added to the entity.

3. Click Save.

Note: Source data is replicated from the integration entity. If you add or delete columns from
the Integration, however, it is not automatically done in the Source.

To add: Once you have added the column, delete themapping link and re-map from the Source
to Integration.

To delete: Right-click the deleted column, delete themapping link and re-map from the Source
to Integration.

Alternatively, you can use theQuick Fix mechanism on the error that appears in the Problems
tab. For details, see "Manage Validation" on page 58.

Map from the Integration to Target:
Once you have added columns to the Integration entity you can perform SSI mapping.

1. In the Engineer Stream Designer, in the palette area, click Column Mapping in the Relations
section tomap the Integration to the Target entity.

2. Drag the arrow from the Integration column to the Target column.
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3. After you have performed the first SSI mapping, a transformation SSI entity is created to which
you can perform further mapping. Any integration entity from the sameCP that should be
mapped to this Target, must bemapped to the transformation entity.

4. Click Save.

Note: If an Integration column is already mapped to a Target column, you cannot perform
further mapping from the sameContent Pack.

Two Integration entity columns from the sameContent Pack cannot bemapped to the
same Target entity column.

UI Description
Engineer Stream Designer View
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Palette Area

UI Element Description

Target Entity
l New Target Entity. Select to display a new Target entity.

l Load Target Entity. Opens the Resource Selector dialog box. Select
the relevant entity for your model.

l Target Column. Adds columns to entities. Column properties, for
example column type, can be edited in the Properties tab.

Each added attribute impacts the relevant entity generations.
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UI Element Description

Integration
Entity

Contains the following Integration entity options:

l New Integration Entity. Select to display a new Integration entity.

l Load Integration Entity. Opens the Resource Selector dialog box.
Select the relevant entity for your model.

l Integration Column. Adds columns to entities. Column properties, for
example column type, can be edited in the Properties tab.

Each added attribute impacts the relevant entity generations.
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UI Element Description

Source Entity Contains the following Source entity options:

l New Source Entity. Select to display a new Source entity.

l Load Source Entity. Opens the Resource Selector dialog box.Select
the relevant entity for your model.

l Source to Integration Relation. The Sourcemust bemapped to the
Integration in order to map to the Target. A green arrow is displayed
between the entities.

Transformation Click tomap the displayed entities.

l Column Mapping.Mapping between the Integration and Target
columns. First timemapping is done from the Integration column to the
Target column. A black arrow is displayed between the entities.

First-timemapping creates a new entity for Transformation. Subsequent
mappings are done to the new Transformation entity.
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Properties tab for Integration
To view the Properties tab, right-click on the specific entity and click Show Properties View.

Note: Properties data is replicated in the Integration and Source columns. If you add or delete
columns from the Integration, however, it is not automatically done in the Source.

To add: Once you have added the column in the properties tab, delete themapping link and re-
map from the Source to Integration.

To delete: Right-click the deleted column, delete themapping link and re-map from the Source
to Integration.

UI Element Description

General tab Displays theGeneral entity attributes.

Columns tab Displays column information:

l ID. The ID of the column. It is taken fro themapped integration column
and is read-only.

l Business name. The complete business name.

l Description. Enter a description of the entity.

l Data Type. Varchar, Int 16, Int 32, Float, Localized Date Time

l Length. Only for Varchar data type. The length of a Varchar columnmust
bemore than 0 and less than 4000.

l Null Allowed. Select if the field can have the value NULL. If you specify
a Business Key, at least one of the columns must not Null Allowed.

l Business Key. Primary key of the Integration field order. Select a
number for the order of columns for placement. When no number has
been assigned, you can only select 1. Subsequently you can assign any
number to a column. If you change a number, all other assigned columns
are automatically shifted down a spot in the order.

Example If you change the Business Key of a column to 1, the one
that was specified previously as 1 becomes 2.

l Last Modified. The last date that the source has been changed. Select
the button if you want a query from a certain date and not all possible
data.
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Properties tab for Source
To view the Properties tab, right-click on the specific entity and click Show Properties View.

UI
Element Description

General
tab

General attributes:

l ID. The entity ID.

l Content Pack. The Source Content Pack information.

Data Source SQL Clauses:

l Group by. The section in the SQLQuery for the aggregation.

l Table Name/Join Condition. Default is Integration entity name. If you change
the table name, youmust also change it in the columns. Enter the Join Condition
for an SQL query with join.

l Where.Where to extract for the SQL query for filtering data from the source.

Columns
tab

Displays column information. The Source entity receives all of the Integration entity
properties.

l ID. The ID of the column. It is taken fro themapped integration column and is
read-only.

l Type. Select Fixed, Direct, orRule. If you select Fixed, youmust enter a Fixed
Value. if you select Rule, youmust enter the Calculation Rule.

l Not Applicable.

l Table Name. Based on table name entered in the General tab. Relevant only if
Direct type is selected.

l Column Name. The field name. Must be what appears in the Source entity.

l Fixed Value. The fixed value of the column. Relevant only if Fixed type is
selected.

l Calculation Rule. The calculation rule of the column. Relevant only if Rule type
is selected. The IDE does not support non UTF-8 characters in theCalculation
Rule field.

For details on the Properties for Target entities, see "Properties tab for Target entity and specific
fields" on page 41

For details on the Properties tab for Associated Dimensions, see "Properties tab for Associated
Dimensions" on page 43.
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Extend the Period Entity
The Period target entity requires special mapping requirements in the IDE. The entity contains time
and date relatedmapping and can only connect to date related sources and dimensions, for
example START_TIME.

When you connect to a data source that has a Period entity, the data source consistently changes
depending on configurations. Therefore you can only map to date-related entities and dimensions.
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Delete an Entity Permanently
The IDE enables you to permanently delete an entity that is not needed or supported, from the file
system. Make sure that no other entity contains any reference to the deleted entity.

Note:When you right-click a selected entity and click Delete From Model, the entity is only
removed from the current designer and not from the file system.

To permanently delete an entity:

1. Delete the relevant entity from the canvas.

2. In the Package Explorer, expand the content pack that contains the entity you want to delete,
for example cp-sa.

HP IT Executive Scorecard (9.41) Page 56 of 108



3. Delete the actual entity, for examplePOLICY, from the Package Explorer.
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Manage Validation
The IDE performs validations on all Designers and entities created in the Designers. After you save
your changes, click the Problems tab, below, to view the errors and warnings that occurred during
content development. Additionally, IDE provides aQuick Fix solution option to enable you tomake
the required fixes for validation. All validations are performed only after you have saved your
changes to the Designers.

Additionally, you canmanually perform validations on all Designers and fix relevant errors and
warnings. To activate, click in the toolbar, or select DW Content > Validate.

During the validation process, a Progress Information dialog box appears specifying the current
validated designer and its progress. Click Cancel to cancel the validation process.

In case of an unreadable designer, an error dialog appears, listing the problem designer diagrams.
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Quick Fix
The validation process also includes aQuick Fix validation which provides recommendations for
solutions for validation problems displayed in the Problems tab.

To use theQuick Fix option:

1. In theProblems tab, under theWarnings orErrors list, right-click a warning or error and
select Quick Fix to open theQuick Fix dialog box.
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2. Select the fix for the specific warning and click Finish.

3. Click Save and the error is removed.

Validation Table
Make sure all entities have been configured properly according to the following validations. An error
or warning appears in the Problems tab once you havemade the problematic change, and saved it.
Note the validations that have theQuick Fix option available.
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Error Text Validation Source Integration Target
Quick
Fix

Target <Target
ID> column
<Column ID> - id
length is greater
than allowed

Integration
<Integration ID>
column <Column
ID>:- id length is
greater than
allowed

Length of column names
(including system suffix)

Up to 60
characters

Up to 60
characters

Up to 60
characters

Target <Target
ID>: id length is
greater than 50
characters

Integration
<Integration ID> id
length is greater
than 44 characters

Length of entity names
(including system suffix)

Up to 60
characters

Up to 44
characters

Up to 50
characters

Sample errors:

Target <Target
ID>: 'Business
Name' field
contains
backslash (\)
character

Integration
<Integration ID>
'Description' field
contains
backslash (\)
character

Source <Source
ID>: 'Group By'
field contains
backslash (\)
character

Backslash ( \) is not
permitted in any field text.

ü ü ü ü
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Error Text Validation Source Integration Target
Quick
Fix

Target <Target
ID> column
<Column ID> id
attribute violates
DW Platform
reserved prefixes:
starts with non
alphabetic
character

Integration
<Integration ID>
column <Column
ID>: id attribute
violates DW
Platform reserved
prefixes: starts
with non
alphabetic
character

Entity names and column
names must start with
alphabetic characters.

ü ü ü ü

Target entity is
invalid. File
containing the
metadata was
deleted

Integration entity
is invalid. File
containing the
metadata was
deleted

Source entity is
invalid. File
containing the
metadata was
deleted

Make sure an entity
deleted from the file
system is also deleted
from the designer diagram.

ü ü ü

Target <Target
ID> column
<Column ID>
DataType is not
defined

Make sure Data Type is
defined for all Target
columns.

ü
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Error Text Validation Source Integration Target
Quick
Fix

Target <Target
ID>: no column is
defined as SCD
for dimension
entity

Make sure when a Target
entity is defined as a
Dimension that SCD
Type is defined for at least
one column.

ü ü

Target <Target
ID>: no column is
defined as
measure for fact
entity

Make sure when a Target
entity is defined as a Fact
thatMeasure is selected
for at least one column.

ü ü

Target <Target
ID>: not defined
as FACT or
DIMENSION

Make sure a Target entity
is defined as a Fact, or
Dimension, or both. The
entity type cannot be left
unselected.

ü

Target <Target
ID>: no column is
defined as SCD
for dimension
entity

Target <Target
ID>: no column is
defined as
measure for fact
entity

Make sure that when a
Target entity is defined as
a Dimension and a Fact,
that at least one column in
the entity is defined
accordingly for each type.

Note: If the Target
entity contains only
associated
Dimensions, this
validation is not
performed.

ü ü

Target <Target
ID>: Invalid target
extension. Target
type doesn't
match

Make sure that the data
type in the extended entity
equals the type of the base
entity.

ü

Target <Target
ID> column
<Column ID> - id
is not unique in
target extension

Make sure column or
Associated Dimension ID
is unique in the Target
extension

ü
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Error Text Validation Source Integration Target
Quick
Fix

Target <Target
ID>: Target
extension
contains loop

Make sure Target
extension does not contain
a loop, meaning the
extension of a base entity
can not also have the base
entity as an extension.
That would place the
entities in a loop with each
other.

ü

Target <Target
ID> column
<Column ID> id
attribute violates
DW Platform
reserved prefixes:
starts with non
alphabetic
character

Integration names and in
the columns first character
must be a letter:
[a-z][A-Z].

ü ü ü ü
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Error Text Validation Source Integration Target
Quick
Fix

Target <Target
ID>: id attribute
violates DB
character
constraints (a-z A-
Z 0-9 $ # _)

Target <Target
ID> Associated
Dimension
<Associated
Dimension ID> id
attribute violates
DB character
constraints (a-z A-
Z 0-9 $ # _)

Target <Target
ID> column
<Column ID> id
attribute violates
DB character
constraints (a-z A-
Z 0-9 $ # _)

Integration
<Integration ID> id
attribute violates
DB character
constraints (a-z A-
Z 0-9 $ # _)

Integration
<Integration ID>
column <Column
ID>: id attribute
violates DB
character
constraints (a-z A-
Z 0-9 $ # _)

Source <Source
ID> <Column ID>:
'ColumnName'
field violates DB
character
constraints (a-z A-
Z 0-9 $ # _)

Integration names and in
the columns next
characters should be a
letter, a digit, or '_' , '$', or
'#'.

ü ü ü ü
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Error Text Validation Source Integration Target
Quick
Fix

Target <Target
ID>: id attribute
violates DW
Platform reserved
prefixes: MD_ or
DI_

Target <Target
ID> Associated
Dimension
<Associated
Dimension ID> id
attribute violates
DW Platform
reserved prefixes:
MD_ or DI_"

Target <Target
ID> column
<Column ID> id
attribute violates
DW Platform
reserved prefixes:
MD_ or DI_

Integration
<Integration ID>id
attribute violates
DW Platform
reserved prefixes:
MD_ or DI_

Integration
<Integration ID>
column <Column
ID>: id attribute
violates DW
Platform reserved
prefixes: MD_ or
DI_

Integration names and in
the columns must not start
with one of the DW
Platform reserved
prefixes: MD_ or DI_.

ü ü ü ü
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Error Text Validation Source Integration Target
Quick
Fix

Integration
<Integration ID>
no business key is
defined

Integration
<Integration ID>
Business key
sequence is not
defined properly
(Doesn't start at 1
or numbers are not
sequential)

Make sure that the
Business Key is specified.
In case of more than one
Business Key, they must
be in order (1, 2, 3) without
spaces in the numbering.

ü

Integration
<Integration ID>
Business key
sequencemust
contain at least
one columnwhich
is not Nullable

Make sure Null Allowed is
not selected for at least
one of the Business Keys.

ü ü

Target <Target
ID> : No id is
defined for column

Target <Target
ID> column
<Column ID> - id
is not unique

Integration
<Integration ID>
column <Column
ID>:- id is not
unique

Make sure that the column
has an ID and it is unique.

ü ü

Source <Source
ID> <Column ID>:
no value at table
name field

Source <Source
ID> <Column ID>:
no value at db
column name field

If a Source column has
Type set as Direct, then
make sure Table Name
and ColumnName are not
empty.

ü
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Error Text Validation Source Integration Target
Quick
Fix

Source <Source
ID> <Column ID>:
no value at fixed
value field

If a Source column has
Type set as Fixed, then
make sure Fixed Value is
not empty.

ü

Source <Source
ID> <Column ID>:
no value at
calculation rule
field

If a Source column has
Type set as Rule, then
make sure Calculation
Rule is not empty.

ü

Source <Source
ID> <Column ID>:
'ColumnName'
field contains
backslash (\)
character

Source <Source
ID> <Column ID>:
'ColumnName'
field violates DB
character
constraints (a-z A-
Z 0-9 $ # _)

If a Source column has
Type set as Direct, then
make sure ColumnName
does not contain special
characters. This validation
runs only if the Product
Type in the source Content
Pack is the database type
of either MSSQL, Oracle or
MySQL.

ü ü

Source <Source
ID> doesn't
include join
condition

Make sure that the Source
entity has a Join Condition
and Table Name specified.

ü

Source <Source
ID> contained in
<cp Name> is not
referencing to any
integration entity

Make sure that a Source
entity is mapped to an
Integration entity.

ü ü

Source <Source
ID>: columns are
not synchronized
with integration
entity columns

Make sure that the Source
and Integration entities are
synchronized.

ü ü
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Error Text Validation Source Integration Target
Quick
Fix

Integration
<Integration ID>
column <Column
ID>: is not
mapped to target
column and data
type is undefined

Integration
<Integration ID>
column <Column
ID>: contains
invalid mapping

Make sure all mapped
Integration columns are
mapped accordingly to the
Target or have been
assigned a data type.

ü

Target <Target
ID> column
<Column ID> is
defined as
VARCHAR but
has no length

Integration
<Integration ID>
column <Column
ID>: is defined as
VARCHAR but
has no length

Make sure that the length
of a Varchar column is
more than 0.

ü ü

Target <Target
ID> column
<Column ID> is
defined as
VARCHAR but
length is greater
than allowed
(4000)

Integration
<Integration ID>
column <Column
ID>: is defined as
VARCHAR but
length is greater
than allowed
(4000)

Make sure that the length
of a Varchar column is less
than or equal to 4000.

ü ü ü ü
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Error Text Validation Source Integration Target
Quick
Fix

No id is defined for
target entity

No id is defined for
integration entity

Make sure each entity has
an ID defined.

ü ü ü

Target <Target
ID> column
<Column ID> the
id is a DB
reserved word

Integration
<Integration ID>
column <Column
ID>: the id is a DB
reserved word

Make sure the defined
column name does not
contain a reserved word.
For details, seeMSDN
Microsoft SQL Server
reserved keywords list.

ü ü ü
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Generate Content
The IDE can generate the relevant schemas and ETLs that are required for the integration.

The ETLGenerator generates the required artifacts based on themodeling in the previous steps.
The artifacts contain BODS workflows that are imported into the BODS repository as well as the
datamodels and XML files that are imported into the DataWarehousemetadata repository. Once
themetadata has been loaded, the schema generationmechanism performs the schema changes
in the target and the staging databases.

To access:

When a designer is open, the ETL button is displayed in the top right toolbar in the IDE workspace.
If it is not displayed, navigate toWindow > Customize Perspective andmake sureETL Gen is
selected.

Click to begin the ETLGenerator.

Section Navigation l Learn More l Tasks

Learn More
Content Pack Creation Tool
The Content Pack Creation Tool enables you to create a new Content Pack structure using existing
source content packs. This allows you to use the IDE to extend content as well as develop entirely
new Content Packs for use in the DataWarehouse and Executive Scorecard.

The ETLGenerator action is relevant to the selected designer. The ETL button is only displayed
when a designer is open.

Tasks
To create a new entity and a new Content Pack with the ETL Generator:

1. Click in the toolbar on the top right of the IDE workspace to begin the ETLGenerator. The
ETLGenerator dialog box opens.
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2. Select theXS ETL Version number 9.4, 9.30 or 9.31.

3. Select theContent Type: XS Content or Custom Content. This field designates a path in
BODS for the specific content type you are extending or creating.

4. Select theGenerate Content Pack checkbox if you are creating a new Content Pack (not
extending content). This creates a new content pack structure along with the generated ETL
files. This capability is only available when generating the ETL files in the Designer.

Note: TheGenerate Content Pack checkbox is not available when generating the ETL
files from the Architect Target Designer.

When you generate the ETL files from the Engineer Stream Designer, theGenerate
Content Pack checkbox is disabled if there are no source entities in the Engineer Stream
Designer.

5. Browse to the directory where you want the generated Content Pack to be placed. Click OK.
The process may take some time.

6. Proceed to package and deploy your content.

Content Extension Guide for XS IDE Version 9.4
Generate Content
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Package and Deploy Content
After you have run the ETLGenerator and saved the Content Pack, youmust package your new or
extended content solution.

Note: In order to be able to fully revert the changes made by the CP deployment make sure to
back up the Staging, Target and BODS repository databases as the CP undeployment
functionality is not currently supported.

Copy the generated files to the Content Packs folder on the DWH server. Use the automation tool
to deploy the changes in content.

l For Content Packs with added or extended entities:

n The Target CP is deployed when changes are added to the target schema. Re-deploy the
Target CP by running the command
dw_ds_automation.bat -task Redeploy -cp Core.

n The Integration CP is deployed when changes made to an Integration or Source entity. Re-
deploy the i-CP by running the command dw_ds_automation.bat -task Redeploy -cp <CP_
NAME>.

l For new Integrated Content Packs: Make sure your new CP is packaged in the correct folder
structure by selecting theGenerate Content Pack checkbox in the ETLGenerator, and then
copied to the ContentPacks folder in your DWH installation.

1. Run the dw_cp_register.bat tool to register the new Content Pack: dw_cp_register.bat -name
<CP_NAME> -type integration.

2. Configure the datasource.xml file and run command: dw_ds_automation.bat -task
ConfigureInitial -cp <CP_NAME>.

3. Run dw_ds_automation with deploy task: dw_ds_automation.bat –cp <CP_NAME> –task
Deploy.

4. Run dw_ds_automation with activate task: dw_ds_automation.bat –cp <CP_NAME> –task
Activate.
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Activate New Content
After you package and deploy new Content Packs, you activate the content in the Executive
Scorecard Data SourceManagement UI. Content that is created from databases, delimited files, as
well as Excel files can be activated in the customized Data SourceManagement activation.

Select the Data Source Type according to your specific Content Pack source, as follows:

l MSSQL

l Oracle

l MySQL

l Delimited File

l Excel File

To access:
In Executive Scorecard, select Admin > Data Source Management. Click Add Data Source
and select the relevant Content Pack you have created.

Section Navigation l Tasks l UI Description

Tasks
Activate a new Content Pack

1. In Executive Scorecard, select Admin > Data Source Management.

2. Click theAdd data source to open the Data source wizard. The Add Data Source page
opens.

3. Select the CP you created and click Next.

The relevant data source page opens.

4. Enter and select the configuration parameters.

5. Complete the wizard.

The data source instance is activated.

For details on all Executive Scorecard Data SourceManagement capabilities, see Data Source
Management in the IT Executive Scorecard Administrator Guide.
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UI Description

CP Activation Page Options
Activation parameters are based on the Data Source Type of your Content Pack.

MSSQL Database Source CP

UI Element Description

Instance name Enter a name for the data source instance you are activating.

<CP name> Version 1

Time Zone Select the time zone for the data source.

Data Source Type SelectMSSQL.

Username Enter your username used to log on to the database.

Password Enter your password used to log on to the database.

Hostname/IP Address Enter the SQL server database hostname or IP address.

Port Enter the server port number.

Database Name Enter the database name used by the CP.

Initial Load Period
(months)

Select the number of months from which you want the initial data
loaded.

MySQL Database Source CP

UI Element Description

Instance name Enter a name for the data source instance you are activating.

<CP name> Version 1

Time Zone Select the time zone for the data source.

Data Source Type SelectMySQL.

Username Enter your username used to log on to the database.

Password Enter your password used to log on to the database.

Hostname/IP
Address

Enter theMySQL server hostname or IP address.

Port Port for database connections.

Initial Load Period
(months)

Select the number of months from which you want the initial data
loaded.

Content Extension Guide for XS IDE Version 9.4
Activate New Content
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Oracle Database Source CP

Note: TheOracle database can have both Server ID (SID) and Service Name properties, but
the user should specify only one. If you define the SID, then the SID is used, and if you define
Service Name, then Service Name is used. If you define both in the UI, only SID is used.

UI Element Description

Instance name Enter a name for the data source instance you are activating.

<CP name> Version 1

Time Zone Select the time zone for the data source.

Data Source Type Select Oracle.

Username Enter your username used to log on to the database.

Password Enter your password used to log on to the database.

Hostname/IP
Address

Enter the Oracle server hostname or IP address.

SID Enter the unique name of the database.

Service Name Enter the alias used when connecting.

Initial Load Period
(months)

Select the number of months from which you want the initial data
loaded.

Delimited File Source CP

UI Element Description

Instance name Enter a name for the data source instance you are activating.

<CP name> Version 1

Time Zone Select the time zone for the data source.

Data Source Type Select Delimited File.

Folder Path Enter the path where the data source file is located.

Encoding Enter the text encoding of the file. The default is UTF-8.

Field Delimiter Enter the field delimeter for the file, such as ','.

Row Delimiter Enter the row delimeter for the file, such as '\r\n'.

Initial Load Period
(months)

Select the number of months from which you want the initial data
loaded.

Excel File Source CP

Content Extension Guide for XS IDE Version 9.4
Activate New Content
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UI Element Description

Instance name Enter a name for the data source instance you are activating.

<CP name> Version 1

Time Zone Enter the time zone for the data source.

Data Source Type Select Excel File.

Folder Path Enter the path to excel data source file.

Initial Load Period
(months)

Select the number of months from which you want the initial data
loaded.

Content Extension Guide for XS IDE Version 9.4
Activate New Content
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Upgrade Tool
If you intend to develop content from a previous version, youmust perform the upgrade process.
This is done to allow file and content compatibility and simplifies themerging and entity deletion
processes.

To perform an upgrade, select DW Content > Upgrade.

An additional upgrademust be performed in the following cases:

l When you are usingmodels from before the IDE was upgraded.

Possible issues include:

n ETLGen, BODS Export failures.

n Validation errors for all designers when using theValidate button.

n Content pack files cannot be viewed in the default editor.

n Content pack name starts with “null”.

n Entity problems.

l When you have upgradedmodels in a non-upgraded IDE version.

Possible issues include:

n ETLGen, BODS Export failures.

n Validation errors for all designers when using theValidate button.

n In Package Explorer, entity files cannot be viewed by the default editor or entity files appears
with UUID instead of entity name.

n The Upgrade option does not appear in the DW Content menu.

Note: The following content changes require that you perform an additional upgrade on your
IDE version.

n Reverting to older content such as XS 9.3 and 9.31 (from SVN or HPLN).

n Merge of content from another developer's environment using a previous IDE version.
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Advanced Development
Following the ETLGenerator process, you can optionally access the following features and
processes for advanced content development.

"Export from BODS" on the next page

"Data Source Explorer" on page 82

"Generate Entities Automatically" on page 93

"Data Source Extraction Customization" on page 100

"Create an Entity from an Excel File" on page 102
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Export from BODS
The artifacts generated by the ETL contain BODS workflows that are deployed and imported into
the BODS repository. Once the workflows have been changed in BODS, you can then export them
automatically to a directory folder. The BODS export action is based on the selected designer, and
exports the sameworkflows that were generated by the ETLGen for that same designer.

Note: BODS Export can be accessed only when IDE and BODS are installed and running on
the same server.

To access:
When a designer is open, the button is displayed in the top right toolbar in the IDE workspace. If
it is not displayed, navigate toWindow > Customize Perspective andmake sureBODS Export
is selected.

Section Navigation l Tasks

Tasks
Export the workflows from BODS

1. Click to begin the BODS export process. The BODS Export dialog box opens.

2. Select theXS ETL Version number.

3. Select theContent Type: XS Content or Custom Content. This field designates a path in
BODS for the specific content type you are extending or creating.

4. Select theGenerate Content Pack checkbox if you are creating a new Content Pack (not
extending content). This creates a new content pack structure along with the generated ETL
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files. This capability is only available when generating the ETL files in the Engineer Stream
Designer.

Note: TheGenerate Content Pack checkbox is not available when generating the ETL
files from the Architect Target Designer.

When you generate the ETL files from the Engineer Stream Designer, theGenerate
Content Pack checkbox is disabled if there are no source entities in the Designer.

5. Browse to the directory where you want the exported workflows to be saved. Click OK. The
process may take some time.

Note: If you place the workflows in the same folder that the ETLGenerator artifacts were
saved, the previous files will be replaced. If you save to a different location, note that you
will need the ETLGenerator artifacts (datamodel and xml files) to add to the exported
workflows, for use in the DataWarehouse.

6. Copy the ETL artifacts and exported workflows to the Content Packs folder in the Data
Warehouse.

Content Extension Guide for XS IDE Version 9.4
Advanced Development
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Data Source Explorer
The IDE provides a Data Tool Platform plug-in which enables you to connect to a specific data
source and browse the database.The Data Source Explorer enables connection to the data sources
through the SQL, Oracle andMySQL drivers. You can then browse the database tables, make
queries, and view the data source information.

You can also connect to file based data sources with the Open Data Access (ODA). It enables you
to interface with an external data provider.

For details on the ODA, see the Eclipse DTP tutorials.

For details on FBI extractors for each product, see "File Based Integration (FBI) Extractor" on page
7.

Section Navigation l Tasks l UI Description

Tasks
This section includes the following tasks:

"Create a new database connection in the Data Source Explorer" below

"Modify driver definitions" below

"Create a new database connection in the Data Source Explorer" below

Create a new database connection in the Data Source Explorer

1. Navigate toWindow > Show View > Other > Data Management > Data Source Explorer.
The Data Source Explorer tab is displayed.

2. Right-click Database Connections and then right-click New.

3. Select Oracle, SQL Server, or MySQL and click Next.

4. Enter theDatabase, Host, Port number, Username andPassword.

5. Click Test Connection to check for errors with the connection to the database.

6. Click Finish to enable the connection to the database.

You can change the driver definitions or create another driver.

Modify driver definitions

1. Navigate toWindow > Preferences > Data Management > Connectivity > Driver
Definitions.

2. Select the driver you want to change, or click Add to add an additional driver.
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For details on the Data Tool Platform, see the Eclipse DTP tutorials.

Connect to flat file data sources
The IDE can connect to a flat file which contains data. The supported file types are: csv, ssv and
psv. The flat file may contain:

l A file where the first row includes the headers and the rest of the file contains the data.

l A file where the first row includes the headers and the second row contains the data types of
each header. The rest of the file contains the data.

l A file where there is only data and does not contain headers or data types.

1. Navigate toWindow > Show View > Other > Data Management > Data Source Explorer.
The Data Source Explorer tab is displayed.

2. Navigate toODA Data Sources > Flat File Data Source, right-click and select New.

3. Enter the relevant details in the New Flat File Data Source Profile wizard.

For details, see the Eclipse DTP tutorials.

UI Description

Note: IDE provides out-of-the-box drivers for MSSQL, Oracle, andMySQL.

To access:

In the IDE main page, selectWindow > Show View > Other > Data Management > Data
Source Explorer, right click Database Connections and right-click New.

Content Extension Guide for XS IDE Version 9.4
Advanced Development
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Data Source Connection Profile

User interface elements are described below:

UI Element Description

<Driver List> Select SQL, Oracle, or MySQL Server.

Content Extension Guide for XS IDE Version 9.4
Advanced Development
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Specify a Driver and Connection Details

MSSQL Server

UI
Element Description

Database Enter the specific database name.

Host Enter the host server.

Content Extension Guide for XS IDE Version 9.4
Advanced Development
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UI
Element Description

Port
number

Enter the database port.

User
name

Enter the database username.

Password Enter the database password.

New Driver Definition. Click to configure new driver definitions. For details, see
the Eclipse DTP tutorials.

Edit Driver Definition. Click to edit the current driver definitions. If you receive an
error for the driver, check that the correct path is displayed in the driver files of the
JAR list.

Content Extension Guide for XS IDE Version 9.4
Advanced Development
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Oracle Server

UI
Element Description

SID Enter the Server ID, the unique name of the database.

Host Enter the host server.

Content Extension Guide for XS IDE Version 9.4
Advanced Development
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UI
Element Description

Port
number

Enter the database port.

User
name

Enter the database username.

Password Enter the database password.

New Driver Definition. Click to configure new driver definitions. For details, see
the Eclipse DTP tutorials.

Edit Driver Definition. Click to edit the current driver definitions. If you receive an
error for the driver, check that the correct path is displayed in the driver files of the
JAR list.

Content Extension Guide for XS IDE Version 9.4
Advanced Development
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MySQL Server

User interface elements are described below:

UI
Element Description

Database Enter the specific database name.

URL Enter the database URL.

Content Extension Guide for XS IDE Version 9.4
Advanced Development
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UI
Element Description

User
name

Enter the database username.

Password Enter the database password.

New Driver Definition. Click to configure new driver definitions. For details, see
the Eclipse DTP tutorials.

Edit Driver Definition. Click to edit the current driver definitions. If you receive an
error for the driver, check that the correct path is displayed in the driver files of the
JAR list.

Flat File Data Source Profile

To access:

In the IDE main page, selectWindow > Show View > Other > Data Management > Data
Source Explorer, right click Flat File data Source and right-click New.

Create Connection Profile

User interface elements are described below:

Content Extension Guide for XS IDE Version 9.4
Advanced Development
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UI Element Description

Name Enter any name for the flat file.

Description (optional) Enter a description of the data source. This field is optional.

Define File URI

UI Element Description

Select home folder This option is not supported

Enter file URI Browse to the relevant flat file.

Select charset Select the relevant character set.

Select flatfile style Select the flat file type: CSV, PSV, SSV. The IDE does not support the
.tsv style.

Use first line as
column name
indicator.

Select when using a flat file that has headers and data (no data types).
Select when using a flat file that contains both headers and data types.

Content Extension Guide for XS IDE Version 9.4
Advanced Development
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UI Element Description

Use second line as
data type indicator.

Select when using a flat file that contains both headers and data types.

Use trailing null
columns.

Not relevant to the IDE.

Test Connection Click to check the connection to your flat file.

Note:When activating a flat file as a source, remove the data types row from the file.

For details, see the Eclipse DTP tutorials.

Content Extension Guide for XS IDE Version 9.4
Advanced Development
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Generate Entities Automatically
You can generate entities from the source database tables or views, as well as flat files based on
.csv format. This enables you to automatically create Source, Integration or Target entities. Using
the Data Source Explorer, you can connect to the source database and navigate to the source table
or view. The entities are created based on the specific sourcemetadata. MSSQL, Oracle, and
MySQL source databases are supported. You can then load the entity to a new designer located in
an existing project. The entity is then displayed in the new Engineer Stream Designer.

Note:

l The following file formats are supported: .csv, .psv, and .ssv.

l The following file models are supported:

n Column name in first row.

n Column name in first row and data type in second row. Flat files can only be extracted
using this model.

n No column name or data type.

Section Navigation l Tasks l UI Description

Tasks
This section includes the following tasks:

"Automatically generate entities from database tables or views" below

"Automatically generate entities from flat files" on the next page

Automatically generate entities from database tables or views

Note: You can generate Source, Integration or Target entities using the Entity Generator
wizard.

1. Navigate toWindow > Show View > Other > Data Management > Data Source Explorer.
The Data Source Explorer tab is displayed.

2. Select either an SQL, Oracle, or MySQLDatabase and connect to the database.

3. Navigate to Tables orViews and right-click the relevant table or view from which you want to
generate the entity and select Generate DWH Entity.

4. In the Scenario page, select the entity type content pack, either Source, Integration or Target.
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5. For Source or Integration, select the relevant content pack. When you select the Source CP
the Integration CP is automatically displayed.

For Target, select whether the entity is defined as a Fact orDimension.

6. Click Next.

7. In the Load to Designer page, select to either load the entity to aNew Designer, orNo
Designer .

8. If you selectedNew Designer, select from the drop down list, the project where you want the
specific Designer to be located.

9. Click Finish to complete the wizard and create the entity. The new entity is now displayed in
the IDE Package Explorer, and if relevant, loaded in the assigned designer canvas.

Automatically generate entities from flat files

1. Navigate toWindow > Show View > Other > Data Management > Data Source Explorer.
The Data Source Explorer tab is displayed.

2. Navigate toODA Data Sources > Flat File Data Source and right-click the file from which
you want to generate the entity and select Generate DWH Entity.

3. In the Scenario page, select the entity type content pack, either Source, Integration or Target.

4. For Source or Integration, select the relevant content pack. When you select the Source CP
the Integration CP is automatically displayed.

For Target, select whether the entity is defined as a Fact orDimension.

5. Click Next.

6. In the Load to Designer page, select to either load the entity to aNew Designer, orNo
Designer.

7. If you selectedNew Designer, select from the drop down list the project where you want the
specific designer to be located.

8. Click Finish to complete the wizard and create the entity. The new entity is now displayed in
the IDE Package Explorer, and if relevant, loaded in the assigned designer canvas.

UI Description
Entity Generator Wizard

For tables and views:

To access: In the relevant Data Source Explorer database, expand Tables or Views and right-
click an entity to select Generate DWH Entity.

Content Extension Guide for XS IDE Version 9.4
Advanced Development
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Note:When you generate an entity from anOracle database, make sure that if you use
reserved words, they are placed in quotationmarks, for example, "NUMBER".

For flat files:

To access: InODA Data Sources select Flat File Data Source and right-click the file from
which you want to generate the entity and select Create DWH Entity.

Scenario page

Content Extension Guide for XS IDE Version 9.4
Advanced Development
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Note: If you select to generate Integration and Target entities, SSI Column Mapping is
automatically performed and displayed in the relevant designer .

UI Element Description

ID Enter entity name. The current table or view name is the default.

Source
Content
Pack

Select the checkbox and the Source content pack for the specific entity. This
generates a Source entity and automatically selects the relevant Integration
content pack.

Notes:

l If there is only one Source content pack in the workspace it is entered
automatically and cannot be changed.

l This checkbox is disabled if there is no Source content pack in the workspace.
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UI Element Description

Integration
Content
Pack

Select the checkbox and the Integration content pack for the specific entity. The
Integration content pack is automatically populated when the Source CP is
selected.

Notes:

l If there is only one Integration content pack in the workspace it is entered
automatically and cannot be changed.

l If only Integration Content Pack is selected, theNext button is disabled, and
the entity cannot be loaded to a designer.

l This checkbox is disabled if there is no Integration content pack in the
workspace.

Target Select the checkbox and whether the Target entity is defined as aDimension or
Fact. The entity is placed in the core-cp.

If only Target is selected, the entity is loaded to the Architect Target Designer.

Load to Designer page
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UI
Element Description

No
Designer

Select the checkbox and the generated entity is not displayed in a designer canvas.

New
Designer

Select the checkbox for the generated entity to be displayed in a designer canvas.
Select an existing project from the drop down list where the designer will be located.

Note: If a Target entity was generated then the entity is loaded into an Architect
Target Designer only. For Source and Integration entities, they are loaded into
an Engineer Stream Designer.

Complete Entity Generation with SSI mapping displayed in Stream Designer:

IDE Data Types

The follows shows Database Data Types and the conventions used for them in the IDE entity
columns.

Database Data Type IDE Data Type

BIGINT Int32
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Database Data Type IDE Data Type

INTEGER(INT), SMALLINT, NUMERIC, NUMBER Int16

FLOAT, DOUBLE_PRECISION Float

CHARACTER, NVARCHAR, VARCHAR, VARCHAR(2),
CHARACTER_VARYING, CHARACTER_VARYING

VarChar (size)

CHARACTER_LARGE_OBJECT, CLOB, TEXT VarChar (4000)

DATE, TIMESTAMP, TIME, DATETIME, Integration: Date Time
Target: Localized Date Time

RAW16 No IDE Data Type. User must
select a data type or delete the
column.

IMAGE No IDE Data Type. User must
select a data type or delete the
column.

BLOB No IDE Data Type. User must
select a data type or delete the
column.
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Data Source Extraction Customization
Integration with data sources is performed using File Based Integration (FBI). In order to generate
the query executed for the data source, the ETL indicates to the FBI module which source entity to
extract. The FBI then extracts the correlatingmetadata definitions, and uses them in order to
formulate a query.

Tasks
This section includes the following tasks:

"Customize the SourceModel" below

"Make changes in a field name" below

"Customize the SourceModel" below

"Update the data warehousemetadata" on the next page

Customize the Source Model
You can customize the generated query by modifying the source entity xml file. This updates the
sourcemetadata in the DataWarehouse andmatches it to the customized source.

1. Modify the xml and load it into the DataWarehousemetadata repository, use dw_import_
defs.bat.

2. Change the SQL query from the FBI log and run the query on the source databasemake sure
the query is correct and can run without errors.

3. Identify all of the changes.

There are various types of customizations to the sourcemodels supported by the DWH. This
document emphasizes cases where the data source that you extract information from is based on
RDBMS, and entities which are already modeled in the DWH have had field names or table names
changed in the data source’s structure.

The Data Source’s sourcemodel metadata xml files are located under:

<InstallationDirectory>\agora\ContentPacks\<CPname>\dataModel\dataIntegration\source\
<CPName>\<product_version>\<DB_type>\<entity_name>.xml

Example
C:\HPXS\agora\ContentPacks\SM\dataModel\dataIntegration\source\SM\9.2\oracle\SM_
INCIDENTSM1_SRC.xml

Make changes in a field name

l Open the entity xml sourcemodel file and update the source field names inthe
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datasourcecolumnname property in the ColumnMapping tag:

Example

<ns1:ColumnMapping extractioncolumnidentifier="<identifier>" notapplicable="N" >

<ns1:DataSourceMapping datasourcetablenameoraliasname=" <name>"
datasourcecolumnname=" source field name" datasourcecolumntype="XXXXX"/>

</ns1:ColumnMapping>

Make changes in a table name

1. Open the entity xml sourcemodel file and update the DataSourceJoin and DataSourceWhere
tags with the changes.

Examples

<ns1:DataSourceJoin>table name</ns1:DataSourceJoin>

<ns1:DataSourceWhere>field name=1</ns1:DataSourceWhere>

<ns1:DataSourceJoin>table1 A LEFT JOIN table2 B ON A.AAAAA =
B.BBBBB</ns1:DataSourceJoin>

<ns1:DataSourceWhere>A.AAAAAAAA IS NOT NULL</ns1:DataSourceWhere>

2. Change the datasourcetablenameoraliasname property in the ColumnMapping tag to the new
value.

Example

<ns1:ColumnMapping extractioncolumnidentifier="XXXX" notapplicable="N" >

<ns1:DataSourceMapping datasourcetablenameoraliasname=" A" datasourcecolumnname="
XXXX" datasourcecolumntype="XXXXX"/>

</ns1:ColumnMapping>

Update the data warehouse metadata

1. Run the command on the sourcemodel xml update file: C:\<Installation
Directory>\agora\DataWarehouse\bin>\dw_importdefs.bat –topdir <SOURCE MODEL XML
FILE DIR>

2. Start the ETL again using the DW ABC Streams Management UI. For details, see ETL
Management in the IT Executive Scorecard Administrator Guide.
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Create an Entity from an Excel File
You can generate an entity from an Excel file using the IDE Engineer Stream Designer. In the
source entity Properties, youmust specify the Table Name/Join Condition field as the Excel file
and theWhere field as the Excel worksheet. After you generate your content, make sure to activate
the new Content Pack in the Data SourceManagement UI as anExcel file in theData Source
Type field. For details see "Activate New Content " on page 74

Section Navigation l Tasks l UI Description

Tasks
Generate an entity from an Excel file

1. Define a new Content Pack project. For details see "Define New Content Pack Project" on
page 26.

2. Define the Architect Target Designer project and create the Target entity. For details see
"Architect Target Designer Tasks" on page 32.

3. Define the Engineer Stream Designer project. For details see "Engineer Stream Designer
Tasks" on page 45.

4. Proceed with the Engineer Stream Designer tasks by loading the relevant entities.

5. Select New Source Entity in the Source section and click on the canvas. A Source entity is
displayed.

6. Click Source to Integration Relation and drag the display arrow from the Source entity to an
Integration entity. All columns from the Integration entity are copied to the Source entity with
default values.

7. Click on the Source entity.

8. In the Properties tab of the Source entity, enter the excel file name in the Table Name/Join
Condition field, for example ALT_ACTUALCOST.xls

9. In the Properties tab of the Source entity, enter the excel worksheet name in theWhere field,
for example DATA.

10. Add columns and perform mapping as necessary. The column names have tomatch the actual
excel file columns.
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UI Description

Properties tab for Source
To view the Properties tab, right-click on the specific entity and click Show Properties View.

UI
Element Description

General
tab

General attributes:

l ID. The entity ID.

l Content Pack. The Source Content Pack information.

Data Source SQL Clauses:

l Group by. This field is not applicable.

l Table Name/Join Condition. Enter the Excel file name including the extension.
It can have the .xls, or .xlsx extension.

l Where. Enter the specific excel worksheet name.

Content Extension Guide for XS IDE Version 9.4
Advanced Development

HP IT Executive Scorecard (9.41) Page 103 of 108



UI
Element Description

Columns
tab

Displays column information. The Source entity receives all of the Integration entity
properties.

l ID. The ID of the column. It is taken fro themapped integration column and is
read-only.

l Type. Select Fixed, Direct, orRule. If you select Fixed, youmust enter a Fixed
Value. if you select Rule, youmust enter the Calculation Rule.

l Not Applicable.

l Table Name. Based on table name entered in the General tab. Relevant only if
Direct type is selected.

l Column Name. The field name. Must be what appears in the excel file columns.

l Fixed Value. The fixed value of the column. Relevant only if Fixed type is
selected.

l Calculation Rule. The calculation rule of the column. Relevant only if Rule type
is selected. The IDE does not support non UTF-8 characters in theCalculation
Rule field.
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Next Steps
Following the IDE content development and extension process, you have created additional
Content Packs for use in the DataWarehouse. This provides data to Executive Scorecard. Using
the tools of Executive Scorecard, you can customize andmodify your data, in order to access and
display it according to specific formulas and parameters. The process includes:

l Create a custom FBI Extractor:Enables you to develop andmodify an extractor for use with
new content. For details, see the FBI Extractor SDK Guide.

l Manage the Data Sources:Enables you tomanage the integration of extended or new data into
the data warehouse through the activation of data sources.

To access: In Executive Scorecard, select Admin > Data Source Management. For details,
see Data SourceManagement in the IT Executive Scorecard Administrator Guide.

l Manage the ETL:Enables you to perform the essential tasks related to ETL and stream
functionality. It displays the state of active streams, and enables you to schedule and control
stream activity. It also allows you to view the historical data and the archived stream definitions.
All ETLmanagement and functionality is accessed and performed through this UI.

To access: In Executive Scorecard select Admin > ETL Management. For details, see ETL
Management in the IT Executive Scorecard Administrator Guide.

l Create your Context in the Context Designer:Enables you to create andmanage Contexts
(universes). The universes can be based on your target schema tables or on .CSV files that can
be uploaded to the target schema using the Context Designer.

To access: In Executive Scorecard, select Admin >Semantic Layer > Semantic Layer. The
Context Management page opens. For details, see Semantic Layer - Context Designer

l Create KPIs in the Studio:Enables you to create andmanage all of the displayed KPI
elements (based on your content), as well as their interactions with each other: wiring, drill
downs, and other features.

To access: In Executive Scorecard, select Studio. For details, see Create the Executive
Dashboard Contents in the Studio in the IT Executive Scorecard Business Analyst Guide.

l Create Executive Pages in the XS Dashboard:Enables you to set up pages that include
components that are of interest to specific users or groups of users. For each page, the
administrator defines the layout of components on the page, and the interaction of the page
components with one another.

To access: In Executive Scorecard, select Studio. For details, see Dashboard Display in the IT
Executive Scorecard Business Analyst Guide.

l Create CAPs:Enables you to create Content Acceleration Packs that include Scorecards,
KPIs, Dashboard pages that display the Scorecards and KPI components, Contexts
(universes), and .CSV files.
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To access: In Executive Scorecard, select Admin > Context Management
> CAP Management. For details, see Create Content Acceleration Packs in theContent
Acceleration Packs Guide.
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We appreciate your feedback!
If you have comments about this document, you can contact the documentation team by email. If
an email client is configured on this system, click the link above and an email window opens with
the following information in the subject line:

Feedback on Content Extension Guide for XS IDE Version 9.4 (IT Executive Scorecard
9.41)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a webmail client,
and send your feedback to SW-Doc@hp.com.
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